
Chipsmall Limited consists of a professional team with an average of over 10 year of expertise in the distribution

of electronic components. Based in Hongkong, we have already established firm and mutual-benefit business

relationships with customers from,Europe,America and south Asia,supplying obsolete and hard-to-find components

to meet their specific needs.

With the principle of “Quality Parts,Customers Priority,Honest Operation,and Considerate Service”,our business

mainly focus on the distribution of electronic components. Line cards we deal with include

Microchip,ALPS,ROHM,Xilinx,Pulse,ON,Everlight and Freescale. Main products comprise

IC,Modules,Potentiometer,IC Socket,Relay,Connector.Our parts cover such applications as commercial,industrial,

and automotives areas.

We are looking forward to setting up business relationship with you and hope to provide you with the best service

and solution. Let us make a better world for our industry!

Contact us
Tel: +86-755-8981 8866 Fax: +86-755-8427 6832

Email & Skype: info@chipsmall.com Web: www.chipsmall.com

Address: A1208, Overseas Decoration Building, #122 Zhenhua RD., Futian, Shenzhen, China

    



CY8CKIT-042-BLE

Bluetooth® Low Energy (BLE)

Pioneer Kit Guide

Doc. # 001-93731 Rev. *G

Cypress Semiconductor
198 Champion Court

San Jose, CA 95134-1709

Phone (USA): 800.858.1810
Phone (Intnl): +1.408.943.2600

www.cypress.com



Copyrights

CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit Guide, Doc. # 001-93731 Rev. *G 2

Copyrights

© Cypress Semiconductor Corporation, 2014-2015. The information contained herein is subject to change without notice.

Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a

Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted

nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an

express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components

in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user.

The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such

use and in doing so indemnifies Cypress against all charges. 

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by

and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty

provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create

derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom

software and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as

specified in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this

Source Code except as specified above is prohibited without the express written permission of Cypress. 

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS

MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS

FOR A PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials

described herein. Cypress does not assume any liability arising out of the application or use of any product or circuit

described herein. Cypress does not authorize its products for use as critical components in life-support systems where a

malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product

in a life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies

Cypress against all charges. 

Use may be limited by and subject to the applicable Cypress software license agreement. 

CySmart, F-RAM, PRoC, Programmable System-on-Chip, and PSoC Creator are trademarks, and PSoC and CapSense are

registered trademarks of Cypress Semiconductor Corporation. All other products and company names mentioned in this

document may be the trademarks of their respective holders.

Purchase of I2C components from Cypress or one of its sublicensed Associated Companies conveys a license under the

Philips I2C Patent Rights to use these components in an I2C system, provided that the system conforms to the I2C Standard

Specification as defined by Philips. As from October 1st, 2006 Philips Semiconductors has a new trade name - NXP

Semiconductors.

Flash Code Protection

Cypress products meet the specifications contained in their particular Cypress Datasheets. Cypress believes that its family of

products is one of the most secure families of its kind on the market today, regardless of how they are used. There may be

methods, unknown to Cypress, that can breach the code protection features. Any of these methods, to our knowledge, would

be dishonest and possibly illegal. Neither Cypress nor any other semiconductor manufacturer can guarantee the security of

their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Cypress is willing to work with the customer who is concerned about the integrity of their code. Code protection is constantly

evolving. We at Cypress are committed to continuously improving the code protection features of our products.
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Safety Information

The CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit is intended for use as a

development platform for hardware or software in a laboratory environment. The board is an open

system design, which does not include a shielded enclosure. Therefore, the board may cause

interference with other electrical or electronic devices in close proximity. 

In a domestic environment, this product may cause radio interference. In such cases, the user

should take adequate preventive measures. Also, this board should not be used near any medical

equipment or critical RF devices. The kit is not intended for general consumer use. Cypress

recommends that the kit only be used in a shielded room.

Attaching additional wiring to this product or modifying the product operation from the factory default

may affect its performance and cause interference with other apparatus in the immediate vicinity. If

such interference is detected, suitable mitigating measures should be taken.

The CY8CKIT-042-BLE, as shipped from the factory, has been verified to meet with the

requirements of CE as a Class A product.

CY8CKIT-042-BLE boards contain ESD-sensitive devices.

Electrostatic charges readily accumulate on the human body and any

equipment, and can discharge without detection. Permanent damage

may occur on devices subjected to high-energy discharges. Proper

ESD precautions are recommended to avoid performance degradation

or loss of functionality. Store unused CY8CKIT-042-BLE boards in the

protective shipping package.

End-of-Life/Product Recycling

The end-of-life cycle for this kit is five years from the date of

manufacture mentioned on the back of the box. Contact your nearest

recycler to discard the kit.
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General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform

procedures only at an ESD workstation. If an ESD workstation is not available, use appropriate ESD

protection by wearing an antistatic wrist strap attached to the chassis ground (any unpainted metal

surface) on the board when handling parts.

Handling Boards

CY8CKIT-042-BLE boards are sensitive to ESD. Hold the board only by its edges. After removing

the board from its box, place it on a grounded, static-free surface. Use a conductive foam pad if

available. Do not slide the board over any surface.

Battery Care and Use

■ Use the correct size and type of battery specified in this guide. 

■ Keep battery contact surfaces and battery compartment contacts clean by rubbing them with a 

clean pencil eraser or a rough cloth each time you replace batteries. 

■ Remove the battery from a device when it is not expected to be in use for several months. 

■ Make sure that you insert the battery into your device properly, with the + (plus) and – (minus) 

terminals aligned correctly. 

■ Do not place the battery next to metallic objects such as keys and coins.

■ Never throw the battery into fire.

■ Do not open up the battery.

■ Do not short the battery.

■ Do not subject the battery to high temperatures or high humidity.

■ Store the battery in a dry place.

■ Do not recharge a battery unless it is marked “rechargeable.”

Battery Disposal

Batteries can be safely disposed with normal household waste. Never dispose batteries in fire

because they can explode. It is important not to dispose large amounts of batteries in a group. Used

batteries are often not completely “dead.” Grouping used batteries together can bring these “live”

batteries into contact with one another, creating safety risks.
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Regulatory Compliance Information

The CY8CKIT-042-BLE kit contains devices that transmit and receive radio signals in accordance

with the spectrum regulations for the 2.4-GHz unlicensed frequency range. 

Cypress Semiconductor Corporation has obtained regulatory approvals for this kit to be used in

specific countries. These countries include the United States (FCC Part 15), Canada (IC RSS210),

and Japan (JRF/TELEC). Additional regional regulatory agency approval may be required to operate

these throughout the world.

This kit, as shipped from the factory, has been tested and found to comply with the limits and

requirements for the following compliances: 

■ As a Class B digital device, pursuant to part 15 of the FCC Rules.

■ As a Class B digital apparatus, compliant with Canadian ICES-003.

Regulatory Statements and Product Labeling

United States (FCC)

The CY8CKIT-142 PSoC 4 BLE and CY5671 PRoC BLE modular transmitter complies with Part 15

of the Federal Communications Commission (FCC) Rules. The FCC ID for these devices are WAP-

CY8CKIT-142 and WAP-CY5671. 

Operation is subject to the following two conditions: 

■ This device may not cause harmful interference

■ This device must accept any interference received, including interference that may cause unde-

sired operation. 

CAUTION: Changes or modifications not expressly approved by the party responsible for

compliance could void the user’s authority to operate the equipment. The antennas for this

transmitter must be installed to provide a separation distance of 20 cm from all persons and must not

be co-located or operating in conjunction with any other antenna or transmitter.

Canada (IC)

This device complies with the Industry Canada license-exempt RSS standard(s). Operation is sub-

ject to the following two conditions: 

■ This device may not cause interference.

CAUTION: 

Only the PCB antenna(s) that were certified with the module may be

used. Other antennas may be used only if they are of the same type

and have the same or lower gain.

The module must be recertified as a Class II permissive change if

the module is built into a different device than the evaluation board

(EVB) it was certified with.

The manufacturer is not responsible for any radio or television

interference caused by unauthorized modifications to this

equipment. Such modifications could void the user's authority to

operate the equipment.
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■ This device must accept any interference, including interference that may cause undesired oper-

ation of the device.

This equipment complies with radio frequency exposure limits set forth by Industry Canada for an

uncontrolled environment. This equipment should be installed and operated with minimum distance

20 cm between the device and the user or bystanders.

CAUTION: Any changes or modifications not expressly approved by the party responsible for com-

pliance could void the user’s authority to operate the equipment.

Contains IC: 7922A-CY8CKIT142 and 7922A-CY5671

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio

exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l'appareil ne doit

pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique

subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Cet équipement est conforme aux limites d'exposition aux radiofréquences définies par Industrie

Canada pour un environnement non contrôlé. Cet équipement doit être installé et utilisé avec un

minimum de 20cm de distance entre le dispositif et l'utilisateur ou des tiers.

Contains IC: 7922A-CY8CKIT142 and 7922A-CY5671

Japan (TELEC)
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1. Introduction

Thank you for your interest in the CY8CKIT-042-BLE Bluetooth® Low Energy (BLE) Pioneer Kit. The

BLE Pioneer Kit enables customers to evaluate and develop BLE projects using the PSoC® 4 BLE

and PRoC™ BLE (Programmable Radio-on-Chip) devices.

Bluetooth SMART™ or Bluetooth Low Energy (BLE) is a full-featured, layered, communication

protocol that includes a 2.4-GHz radio, a link layer, and an application layer. However, you do not

need to understand the complex protocol to implement your projects using PSoC 4 BLE or PRoC

BLE. The Cypress BLE solution, which includes the device, the BLE Component, and the BLE

firmware stack will take care of it for you. The Cypress BLE firmware stack is royalty free.

You will use two software tools, PSoC Creator™ and CySmart™ Central Emulation Tool, to develop

and debug your BLE project. PSoC Creator is Cypress’ standard integrated design environment

(IDE). The BLE protocol has been abstracted into an easy drag-and-drop BLE Component in PSoC

Creator. The CySmart Central Emulation Tool is a host tool for Windows PCs, which provides an

easy-to-use GUI to enable customers to test and debug their BLE projects. 

The BLE Pioneer Kit offers footprint-compatibility with Arduino™ shields as well as 6-pin Digilent®

Pmod™ daughter cards. In addition, the kit features a CapSense® slider, an RGB LED, a push-

button switch, an onboard programmer/debugger and the USB-UART/I2C bridge functionality block

(KitProg), a coin cell battery holder, and a Cypress F-RAM™. The BLE Pioneer Kit supports 1.9 V,

3 V, 3.3 V, or 5 V as operating voltages. 

The BLE Pioneer Kit supports two devices: 

■ PSoC 4 BLE is a 32-bit, 48-MHz ARM® Cortex®-M0 BLE solution with CapSense, 12-bit analog 

front end (1x SAR ADC, 4x low-power opamps, 2x low-power comparators, and 2x current 

DACs), 4x TCPWM1, 2x SCBs2, 4x UDBs3, LCD4, I2S5, and 36 GPIOs. 

PSoC 4 BLE provides a complete solution for sports and fitness monitors, wearable electronics, 

medical devices, home automation systems, and sensor-based low-power systems for the Inter-

net of Things (IoT). 

■ PRoC BLE is a 32-bit, 48-MHz ARM Cortex-M0 BLE solution with CapSense, 12-bit ADC, 4x 

TCPWM1, 2x SCBs2, LCD4, I2S5, and 36 GPIOs. 

PRoC BLE provides a complete solution for BLE connectivity, HID, remote controls, and toys.

Both devices are available in 128KB and 256KB flash configurations. 

Both devices are supported by royalty-free protocol stacks compatible with Bluetooth 4.1 and

Bluetooth 4.2. 

1. Configurable timer, counter, and pulse-width modulator.
2. Serial communication blocks (configurable to I2C, SPI, or UART).
3. Universal digital blocks
4. Configurable liquid crystal display driver.
5. Configurable integrated interchip sound serial bus interface.
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1.1 Kit Contents

The BLE Pioneer Kit contains the following items (see Figure 1-1):

■ BLE Pioneer Baseboard preloaded with the CY8CKIT-142 PSoC 4 BLE Module

■ CY5671 PRoC BLE Module

■ CY5670 CySmart USB Dongle (BLE Dongle)

■ Quick start guide

■ USB Standard-A to Mini-B cable

■ Four jumper wires (4 inch) and two proximity sensor wires (5 inch)

■ Coin cell (3-V CR2032)

Figure 1-1.  Kit Contents

The BLE Modules that are shipped as part of the BLE Pioneer Kit support 128KB flash and Bluetooth

4.1. The BLE Modules that support 256KB flash and Bluetooth 4.2 can be ordered separately. For

more information about these modules, refer to BLE Modules and BLE Dongles Compatible with the

BLE Pioneer Kit on page 149.

If any part of the BLE Pioneer Kit is missing, contact your nearest Cypress sales office for help:

www.cypress.com/go/support.
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1.2 BLE Pioneer Baseboard Details

The BLE Pioneer Baseboard consists of the blocks shown in Figure 1-2.

1. RGB LED

2. BLE device reset button

3. CapSense proximity header

4. User button

5. CapSense slider

6. Arduino-compatible I/O headers (J2/J3/J4)

7. Arduino-compatible power header (J1)

8. Digilent Pmod-compatible I/O header (J5)

9. Cypress F-RAM 1 Mb (FM24V10-G)

10.PSoC 5LP I/O header (J8)

11.PSoC 5LP programmer and debugger (CY8C5868LTI-LP039)

12.Coin cell holder (bottom side)

13.USB connector (J13)

14.Power LED and Status LED

15.System power supply jumper (J16) - LDO 1.9 V~5 V

16.BLE power supply jumper / current measurement (J15)

17.BLE module headers (J10/J11)

Figure 1-2.  BLE Pioneer Baseboard
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Figure 1-3 shows a markup of the onboard components of the PSoC 4 BLE module (in red) and the

PRoC BLE module (in black). See BLE Modules and BLE Dongles Compatible with the BLE Pioneer

Kit on page 149 for more details. Figure 1-4 shows the BLE Dongle board blocks.

Figure 1-3.  BLE Module Markup

Figure 1-4.  BLE Dongle Markup

32.768-kHz
crystal

32.768-kHz
crystal

Feature List and Pinout Description for CySmart USB Dongle
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1.3 PSoC Creator

PSoC Creator™ is a state-of-the-art, easy-to-use integrated design environment (IDE). It introduces

revolutionary hardware and software co-design, powered by a library of pre-verified and pre-

characterized PSoC Components. With PSoC Creator, you can:

1. Drag and drop Components to build your hardware system design in the main design workspace

2. Codesign your application firmware with the PSoC hardware

3. Configure Components using configuration tools

4. Explore the library of 100+ Components

5. Review Component datasheets

Figure 1-5.  PSoC Creator Features

PSoC Creator also enables you to tap into an entire tool ecosystem with integrated compiler chains

and production programming programmers for PSoC devices.

For more information, visit www.cypress.com/psoccreator. Visit PSoC Creator training page for video

tutorials on learning and using PSoC Creator.
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1.3.1 PSoC Creator Code Examples

PSoC Creator includes a large number of code examples. These examples are available from the

PSoC Creator Start Page, as Figure 1-6 shows.

Code examples can speed up your design process by starting you off with a complete design,

instead of a blank page. The code examples also show how PSoC Creator Components can be

used for various applications. Code examples and documentation are included, as shown in

Figure 1-7 on page 16.

In the Find Example Project dialog shown in Figure 1-7, you have several options:

■ Filter for examples based on architecture or device family, that is, PSoC 3, PSoC 4 or PSoC 5LP; 

project name; or keyword.

■ Select from the menu of examples offered based on the Filter Options.

■ Review the example project’s description (on the Documentation tab).

■ Review the code from the Sample Code tab. You can copy the code from this window and paste 

to your project, which can help speed up code development.

■ Create a new project (and a new workspace if needed) based on the selection. This can speed 

up your design process by starting you off with a complete, basic design. You can then adapt that 

design to your application.

Figure 1-6.  Code Examples in PSoC Creator
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Figure 1-7.  Code Example Projects with Sample Code

1.3.2 Kit Code Examples

This kit includes a number of code examples, which can be used to quickly evaluate the functionality

of this kit. These examples are described in the Example Projects chapter on page 37.

1.3.3 PSoC Creator Help

Visit the PSoC Creator home page to download the latest version of PSoC Creator. Then, launch

PSoC Creator and navigate to the following items:

■ Quick Start Guide: Choose Help > Documentation > Quick Start Guide. This guide gives you 

the basics for developing PSoC Creator projects.

■ Simple Component example projects: Choose File > Code Example. These example projects 

demonstrate how to configure and use PSoC Creator Components.

■ System Reference Guide: Choose Help > System Reference Guide. This guide lists and 

describes the system functions provided by PSoC Creator.

■ Component datasheets: Right-click a Component and select Open Datasheet, as shown in 

Figure 1-8 on page 17. Visit the PSoC 4 Component Datasheets page for a list of all PSoC 4 

Component datasheets.

■ Document Manager: PSoC Creator provides a document manager to help you to easily find and 

review document resources. To open the document manager, choose the menu item Help > 

Document Manager.
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1.3.4 Component Datasheets

Right-click a Component and select Open Datasheet (see Figure 1-8 on page 17).

Figure 1-8.  Opening Component Datasheet

1.4 Getting Started

This guide will help you get acquainted with the BLE Pioneer Kit:

■ The Software Installation chapter on page 21 describes the installation of the kit software. This 

includes the PSoC Creator IDE for development and debugging applications, PSoC Programmer 

for programming hex files, and the CySmart Central Emulation Tool for BLE Central emulation.

■ The Kit Operation chapter on page 25 describes the major features of the BLE Pioneer Kit such 

as USB-UART and USB-I2C bridges and functionalities such as programming and debugging.

■ The Example Projects chapter on page 37 describes multiple PSoC 4 BLE and PRoC BLE code 

examples that will help you understand how to create your own BLE application using the BLE 

Component and device.

■ The Hardware chapter on page 108 details the hardware content of the BLE Pioneer Kit and BLE 

Dongle, and the hardware operation.

■ The Advanced Topics chapter on page 135 explains the functionality of FM24V10 F-RAM.

■ The Appendix on page 137 provides the bill of materials (BOM), KitProg LED states, list of BLE 

modules and dongles compatible with the BLE Pioneer Kit, migrating projects across Pioneer 

series kits, and programming BLE modules using MiniProg3.

1.5 Additional Learning Resources

Cypress provides a wealth of information at www.cypress.com to help you to select the right PSoC

device for your design, and to help you to quickly and effectively integrate the device into your

design. For a comprehensive list of resources, see KBA86521, How to Design with PSoC 3, PSoC 4,

and PSoC 5LP. 

Visit www.cypress.com/go/psoc4ble and www.cypress.com/procble for additional learning resources

including datasheets, technical reference manuals, and application notes.The following is an abbre-

viated list:

■ Overview: PSoC 4 BLE Portfolio and PSoC Roadmap

■ Product Selectors: PSoC 1, PSoC 3, PSoC 4, or PSoC 5LP. In addition, PSoC Creator includes a 

device selection tool.

■ Datasheets: Describe and provide electrical specifications for the PSoC 4 device family

■ CapSense Design Guide: Learn how to design capacitive touch-sensing applications with the 

PSoC 4 family of devices.

■ Application Notes and Code Examples: Cover a broad range of topics, from basic to advanced 

level. Many of the application notes include code examples. Visit the PSoC 3/4/5 Code Examples 

webpage for a list of all available PSoC Creator code examples. To access code examples from 

within PSoC Creator, see PSoC Creator Code Examples on page 15.
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■ Technical Reference Manuals (TRM): Provide detailed descriptions of the architecture and 

registers in each PSoC 4 device family.

■ Development Kits:

❐ CY8CKIT-040, CY8CKIT-042, and CY8CKIT-044 are easy-to-use and inexpensive develop-

ment platforms. These kits include connectors for Arduino-compatible shields and Digilent 

Pmod peripheral modules.

❐ CY8CKIT-141, CY8CKIT-143, CY8CKIT-143A, CY5674, CY5676, and CY5676A are addi-

tional BLE Modules compatible with the BLE Pioneer Kit.

❐ CY5677 is additional BLE Dongle compatible with the BLE Pioneer Kit.

❐ CY8CKIT-049 is a very low-cost prototyping platform for PSoC 4100/4200 families.

❐ The MiniProg3 kit provides an interface for flash programming and debug.

❐ CY5672 PRoC BLE Remote Control Reference Design Kit provides a production-ready imple-

mentation of a Bluetooth Low Energy remote control.

❐ CY5682 PRoC BLE Touch Mouse Reference Design Kit provides a production-ready imple-

mentation of a Bluetooth Low Energy touch mouse.

■ Knowledge Base Articles (KBA): Provide design and application tips from experts on using the 

device.

■ PSoC Creator Training: Visit www.cypress.com/go/creatorstart/creatortraining for a 

comprehensive list of video trainings on PSoC Creator.

■ Cysmart Central Emulation Tool: Visit www.cypress.com/go/cysmart for information on the 

CySmart Central Emulation Tool.

■ Learning From Peers: Visit www.cypress.com/forums to meet enthusiastic PSoC developers 

discussing the next generation embedded systems on Cypress Developer Community Forums.

1.5.1 Bluetooth Learning Resources

The Bluetooth Developer Portal provides material by the Special Interest Group (SIG) for learning

various aspects of the Bluetooth Low Energy protocol and systems. Some of them are:

■ Training videos

■ GATT profiles

■ Bluetooth community forum

1.5.2 Other Related Resources

■ Digilent Pmod: www.digilentinc.com/pmods/

■ Arduino: http://arduino.cc/en/Main/ArduinoBoardUno

1.6 Technical Support

If you have any questions, our technical support team is happy to assist you. You can create a

support request on the Cypress Technical Support page.

If you are in the United States, you can talk to our technical support team by calling our toll-free

number: +1-800-541-4736. Select option 2 at the prompt.

You can also use the following support resources if you need quick assistance.

■ Self-help.

■ Local Sales Office Locations.
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1.7 Documentation Conventions

1.8 Acronyms

Table 1-1.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:

C:\...cd\icc\

Italics
Displays file names and reference documentation:

Read about the sourcefile.hex file in the PSoC Creator User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:

[Enter] or [Ctrl] [C]

File > Open
Represents menu paths:

File > Open > New Project

Bold
Displays commands, menu paths, and icon names in procedures:

Click the File icon and then click Open.

Times New Roman
Displays an equation:

2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.

Table 1-2.  Acronyms Used in this Document

Acronym Definition

ADC analog-to-digital converter

API application programming interface

BD address Bluetooth device address

BLE Bluetooth Low Energy

CDC Communications Device Class

COM communication port

DLE data length extension

ECDH Elliptic Curve Diffie-Hellman

DVD digital video disc

ESD electrostatic discharge

F-RAM ferroelectric random access memory

GATT generic attribute profile

GUI graphical user interface 

GPIO general-purpose input/output

I2C inter-integrated circuit

IAS immediate alert service

IDAC current output digital-to-analog converter

IDE integrated development environment

LDO low drop out (voltage regulator)

LE low energy

LED light-emitting diode
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LP low power

LPT line print terminal

MTU maximum transmission unit

OTA over-the-air

PHY physical layer

PrISM Precise Illumination Signal Modulation

PRoC Programmable Radio-on-Chip

PSM protocol service multiplexer

PSoC Programmable System-on-Chip

PWM pulse width modulation 

QFN quad flat no-lead (package)

RDK reference design kit

RGB red green blue

SAR successive approximation register

SIG special interest group

SMA SubMiniature version A

SPI serial peripheral interface 

SWD serial wire debug

TLM telemetry

UART universal asynchronous receiver transmitter

UID universal identifier

URI uniform resource identifier

URL uniform resource locator

USB Universal Serial Bus

UUID universal unique identifier

Table 1-2.  Acronyms Used in this Document

Acronym Definition
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2. Software Installation

This chapter describes the steps to install the software tools and packages on a computer for using

the BLE Pioneer Kit. This includes the IDE in which the projects will be built and used for program-

ming.

2.1 Before You Begin

All Cypress software installations require administrator privileges. Ensure you have the required

privileges on the system for successful installation. Before you install the kit software, close any

other Cypress software that is currently running.

2.2 Install Software

Follow these steps to install the BLE Pioneer Kit software:

1. Download the kit software from www.cypress.com/CY8CKIT-042-BLE. The software is available

in the following formats:

a. CY8CKIT-042-BLE Kit Complete Setup: This installation package contains the files related to

the BLE Pioneer Kit. However, it does not include the Windows Installer or Microsoft .NET

framework packages. If these packages are not on your computer, the installer directs you to

download and install them from the Internet.

b. CY8CKIT-042-BLE Kit Only Package: This executable file installs only the BLE Pioneer Kit

contents, which include code examples, hardware files, and user documents. This package

can be used if all the software prerequisites (listed in step 5) are installed on your computer.

c. CY8CKIT-042-BLE DVD ISO: This file is a complete package, stored in a DVD-ROM image

format, that you can use to create a DVD or extract using an ISO extraction program such as

WinZip or WinRAR. The file can also be mounted similar to a virtual CD/DVD using virtual

drive programs such as ‘Virtual CloneDrive’ and ‘MagicISO’. This file includes all the required

software, utilities, drivers, hardware files, and user documents.

2. If you have downloaded the ISO file, mount it on a virtual drive; if you do not have a virtual drive

to mount, extract the ISO contents using the appropriate ISO extractor (such as MagicISO or

PowerISO). Double-click cyautorun.exe in the root directory of the extracted content or mounted

ISO if “Autorun from CD/DVD” is not enabled on the computer. The installation window will

appear automatically. 

Note: If you are using the “Kit Complete Setup” or “Kit Only Package” file, then go to step 4 for 

installation.
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3. Click Install CY8CKIT-042-BLE Kit to start the installation, as shown in Figure 2-1.

Figure 2-1.  Installer Screen

4. Select the folder in which you want to install the CY8CKIT-042-BLE kit-related files. Choose the

directory and click Next.

5. When you click Next, the CY8CKIT-042-BLE Kit installer automatically installs the required

software, if it is not present on your computer. The following software packages are required: 

Note: For the Kit Only Package, download and install the following prerequisites.

a. PSoC Creator 3.3 or later: Download the latest version from www.cypress.com/psoccreator.

b. PSoC Programmer 3.24 or later: This is installed as part of PSoC Creator installation

(www.cypress.com/programmer).

c. CySmart 1.2 or later: Download the latest version from www.cypress.com/cysmart.
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6. Choose the Typical/Custom/Complete installation type in the Product Installation Overview

window, as shown in Figure 2-2. Click Next after you select the installation type.

Figure 2-2.  Product Installation Overview

7. Read the license agreement and select I accept the terms in the license agreement to

continue with installation. Click Next.

8. When the installation begins, a list of packages appears on the installation page. A green check

mark appears next to each package after successful installation.

9. Click Finish to complete the CY8CKIT-042-BLE kit installation.

10.Enter your contact information or select the Continue Without Contact Information check box.

Click Finish to complete the CY8CKIT-042-BLE kit installation.

11.After the installation is complete, the kit contents are available at the following location:

<Install_Directory>\CY8CKIT-042-BLE Kit

Default location:

Windows 7 (64-bit): C:\Program Files (x86)\Cypress\CY8CKIT-042-BLE Kit

Windows 7 (32-bit): C:\Program Files\Cypress\CY8CKIT-042-BLE Kit

Note: For Windows 7/8/8.1 users, the installed files and the folder are read only. To use the installer

example projects, follow the steps outlined in the Example Projects chapter on page 37.

The BLE Pioneer Kit installer also installs the CySmart Central Emulation Tool on your computer.

This software, along with the BLE Dongle, allows the computer to emulate as a BLE Central device.
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2.3 Windows 8.1 USB Selective Suspend Setting

The Windows 8.1 operating system issues a suspend command to a connected USB device if there

is no activity on its USB bus. This may happen to the BLE Pioneer Kit/BLE Dongle if the driver instal-

lation is not complete or the driver is not found. In this situation, as a response to the suspend com-

mand from the operating system, the KitProg will shut down the onboard LDO to remain within the

USB suspend current requirement. Due to this, the BLE Pioneer Kit will not be powered and will not

be functional.

To prevent this, do either of the following:

■ Install the kit software on the Windows 8.1 operating system before using the BLE Pioneer Kit.

■ Disable the USB selective suspend setting for the BLE Pioneer Kit from Power Options on Win-

dows 8.1, by following these steps:

a. From Control Panel, go to Power Options.

b. Click Change Plan Settings corresponding to your power plan.

c. Click Change Advanced Power Settings.

d. Under Advanced settings, expand USB Settings > USB selective suspend setting.

e. Select the Disabled option for Plugged in and On battery operation.

f. Click OK.
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3. Kit Operation

This chapter introduces you to the BLE Pioneer Kit and the features that will be used as part of its

operation. We will discuss features such as USB connection, programming/debugging, and

programmer firmware update. The chapter also describes the USB-UART and USB-I2C bridges

along with the PC tools that can be used to communicate with the BLE device on the BLE Pioneer

Kit.

3.1 Theory of Operation

Figure 3-1, Figure 3-2, and Figure 3-3 show the block diagrams for the BLE Pioneer Baseboard,

PSoC 4 BLE/PRoC BLE Module, and BLE Dongle.

Figure 3-1.  BLE Pioneer Baseboard Block Diagram

The BLE Pioneer Baseboard acts as the baseboard for the PSoC 4 BLE (red module) and PRoC

BLE (black module). The BLE Pioneer Baseboard contains a PSoC 5LP device, that has KitProg

firmware, used as an onboard programmer or debugger, and for the USB-Serial interface.

The baseboard is Arduino form-factor compatible, enabling Arduino shields to be connected on top

of the board to extend the functionality of BLE modules. The board also features a 1-Mb F-RAM, an

RGB LED, a five-segment CapSense slider, a proximity header, a user switch, and a reset switch for

the PSoC 4 BLE and PRoC BLE devices on the module. The Pioneer board supports three voltage

levels: 1.9 V, 3.3 V, and 5 V.

GPIO

Status LED 
Green

BLE/Arduino Compatible Headers  

Proximity wire 
header

CapSense Slider 
5 Segment

Reset SW  
(Push Button)

USB 
Mini B

KitProg 
Programmer/Serial 

Communication

KitProg               
10 pin  Prog. header

KitProg I/Os

16 pin  Expansion header

PMOD header
6 pin PMOD header

ESD 
Protection

MOSFET 
Protection ckt

LDO
ORing 
Diodes

BLE/Arduino Compatible Headers  

Jumper
BLE current measuring 

Coin cell
Battery holder

Power 
LED Red

BLE Module I/Os 
20 pin header

FRAM

I2C pull-up
via FET

ORing 
Diodes

User SW   
(Push Button)

BLE Module I/Os         
24 pin header

VIN

VBUS 

VCC

D+ / D-

VDD

XRES

3.3V

~3V

SWD
I2C / UART

I2C

Voltage Ctrl 
3 pin Jumper

RGB LED

MOSFET 
Protection ckt

BLE SWD
10 pin  Prog. header

3.3V

Power Signal

GPIO


	Contact us
	Bluetooth® Low Energy (BLE) Pioneer Kit Guide
	Contents
	General Safety Instructions
	Regulatory Compliance Information
	United States (FCC)
	Canada (IC)
	Japan (TELEC)


	1. Introduction
	1.1 Kit Contents
	1.2 BLE Pioneer Baseboard Details
	1.3 PSoC Creator
	1.3.1 PSoC Creator Code Examples
	1.3.2 Kit Code Examples
	1.3.3 PSoC Creator Help
	1.3.4 Component Datasheets

	1.4 Getting Started
	1.5 Additional Learning Resources
	1.5.1 Bluetooth Learning Resources
	1.5.2 Other Related Resources

	1.6 Technical Support
	1.7 Documentation Conventions
	1.8 Acronyms

	2. Software Installation
	2.1 Before You Begin
	2.2 Install Software
	2.3 Windows 8.1 USB Selective Suspend Setting


